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terms and conventions

The following terms and conventions are used in the user's guide.

terms

The HP Deskjet printer may be referred to as the HP printer or printer.

symbols

The > symbol guides you through a series of software steps. For example:

Click File > Print.

cautions and warnings

A Caution indicates possible damage to the HP Deskjet printer or to other 
equipment. For example:

Caution!   Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and bad 
electrical connections.

A Warning indicates possible harm to you or to others. For example:

 
Warning!   Keep both new and used print cartridges out of the reach 
of children.

icons

A Note icon indicates that additional information is provided. For example:

 For great results use HP products.

A Mouse icon indicates that additional information is available through the What's 
This? help feature. For example:

 

To find more information about options on each tab screen, point to 
an option and click the right mouse button to display the What's 
This? dialog box. Click What's This? to view information about the 
selected option.

A Do Not icon indicates that an action is not recommended.



 Do not clean the interior of the printer.



accessibility 

Your HP printer provides a number of features that make it accessible for people with 
disabilities. 

visual 

The printer software is accessible for users with visual impairments or low vision 
through the use of Windows accessibility options and features. It also supports most 
assistive technology such as screen readers, Braille readers, and voice-to-text 
applications. For users who are color blind, colored buttons and tabs used in the 
software and on the HP printer have simple text or icon labels that convey the 
appropriate action. 

mobility 

For users with mobility impairments, the printer software functions can be executed 
through keyboard commands. The software also supports Windows accessibility 
options such as StickyKeys, ToggleKeys, FilterKeys, and MouseKeys. The printer 
doors, buttons, paper trays, and paper guides can be operated by users with limited 
strength and reach. 

support 

For more details about the accessibility of this product and HP's committment to 
product accessibility: 

●     Visit HP's Web site at: www.hp.com/accessibility 

●     Email HP at: accessibility@hp.com 



special features

Congratulations! You have purchased an HP Deskjet printer that is equipped with 
several exciting features:

●     Brilliant photo-quality printing: Great printing performance with the black 
and tri-color print cartridges installed.

●     Six-ink upgradeable printing: Enhance photo printing with a photo print 
cartridge (purchased separately).

●     Borderless printing: Print 4 x 6 inch photos and cards to the edges of the 
paper using the borderless printing feature.

●     User friendly: Easy to install and operate.

●     Cancel button: Save paper and ink by cancelling print jobs quickly and easily 
with the Cancel button.

●     Ink level indicator: Know the approximate ink level of each print cartridge 
with the onscreen ink level indicator.

●     Compact: Small, lightweight, and easy to set up, store, or carry.

●     Quality: Built to give you the best results for your printing needs.

 



print cartridges 

Three print cartridges can be used with the printer. 

●     black print cartridge 

●     tri-color print cartridge 

●     photo print cartridge 

 
1. black print cartridge 2. tri-color print cartridge 3. photo print cartridge 

Not all print cartridges may be packaged with your printer. 

print cartridge selection 

printer model print cartridge selection 
number 

product 
number 

HP Deskjet 3600 
Series (except HP 
Deskjet 3658/3668) 

black 27 c8727 

tri-color 28 c8728 

photo 58 c6658 

HP Deskjet 
3658/3668 

Please refer to the graphic instructions located under 
the printer cover, or the hardcopy reference guide that 
was included with your printer. 

For installation instructions, click here . 

For storage instructions, click here . 

For recycling instructions, click here . 

 
For print cartridge ink capacity, see the information included in the 
print cartridge packaging. 

For great performance from your HP printer, use only genuine, factory-filled HP print 
cartridges. 



Caution!    Damage that is directly attributable to modified or refilled 
HP print cartridges is specifically excluded from the HP printer's 
warranty coverage. 



replacing print cartridges

Before buying replacement print cartridges, verify the correct part numbers.

To replace a print cartridge:

1.  Press the Power button to turn on the printer.

2.  Open the printer cover.

The cradle moves to the center of the printer.

3.  Push down on the print cartridge and slide it out of the print cartridge cradle.

 
1. press power button 2. lift printer cover 3. push down on print cartridge 4. 
slide print cartridge out of cradle

4.  Remove the replacement print cartridge from its packaging and carefully 
remove the plastic tape. Hold the print cartridge so that the copper strip is on 
the bottom and facing toward the printer.

 
1. remove plastic tape

Caution!   Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and 
bad electrical connections. Do not remove the copper strips. They 



are required electrical contacts.

 
1. ink nozzles 2. copper contacts

5.  Slide the print cartridge firmly into the cradle at a slight upward angle until you 
feel resistance.

 

6.  Push the cartridge into the cradle.

You hear a snap when the print cartridge is correctly positioned.

7.  Close the printer cover.

8.  Calibrate the printer for optimum print quality.

For information on how to recycle your empty print cartridges, click here.

 
Warning!   Keep both new and used print cartridges out of the reach 
of children.



calibrating print cartridges

After installing a print cartridge, calibrate the print cartridges to ensure the best print 
quality.

To calibrate print cartridges:

1.  Load a stack of plain white paper in the In tray.

2.  Go to printer maintenance.

3.  Click Calibrate Printer.

4.  Click Calibrate, then follow the onscreen instructions.



print cartridge recovery

Customers interested in recycling their genuine HP print cartridges can participate in 
HP's empty print cartridge return and recycle program. HP offers this program in 
more countries/regions than any other print cartridge manufacturer in the world. This 
program is provided as a free service to HP customers as an environmentally sound 
solution for these products at end-of-life. It is not available in all countries/regions.

To participate, simply request postage-paid return envelopes or bulk boxes via the 
Web at www.hp.com/recycle.

Because HP's unique recycling processes are very sensitive to material 
contamination, we cannot take back and recycle cartridges from other manufacturers. 
The end products of the recycling process are used in the manufacture of new 
products, and HP must ensure the composition of the material is consistent. To do 
that, we recycle only HP original cartridges. This program does not extend to refilled 
cartridges.

Returned cartridges are separated for purification into raw materials for use in other 
industries to manufacture new products. Examples of products made from recycled 
HP print cartridge materials include automobile parts, trays used in microchip 
fabrication processes, copper wire, steel plates, and the precious materials used in 
electronics. Depending on the model, HP is able to recycle up to 65% of the print 
cartridge by weight. The remaining parts that cannot be recycled (ink, foam, and 
composite parts) are disposed of in an environmentally responsible manner.



maintaining print cartridges

The following tips will help maintain HP print cartridges and ensure consistent print 
quality:

●     Keep all print cartridges in their sealed packages until they are needed. Print 
cartridges should be stored at room temperatures (15-35 degrees C or 59-95 
degrees F).

●     Do not remove the plastic tape covering the ink nozzles until you are ready to 
install the print cartridge in the printer. If the plastic tape has been removed 
from the print cartridge, do not attempt to reattach it. Reattaching the tape 
damages the print cartridge.

storing print cartridges

When print cartridges are removed from the printer, store them in a print cartridge 
protector or an airtight plastic container.

A print cartridge protector comes with the photo print cartridge. If you store the print 
cartridge in an airtight plastic container, make sure that the ink nozzles face down 
but are not in contact with the container.

inserting the print cartridge into the print cartridge protector

Slide the print cartridge at a slight angle into the protector, and snap it securely in 
place.

 

removing the print cartridge from the print cartridge protector

Press down and back on the top of the protector to release the cartridge. Slide the 
cartridge out of the protector.



 

Caution!   Do not drop the print cartridge. Dropping the print cartridge 
may damage it.



borderless printing

Borderless printing lets you print to the edges of photographs and certain card sizes. 
The printer prints borderless photos measuring 4 x 6 inches or less.

When you print on 4 x 6 inch photo paper with tear-off tabs, the printout is 
completely borderless after the tear-off strip is removed.

 

When you print on 4 x 6 inch photo paper without tear-off tabs, A6 cards, and 
greeting cards, the printout is borderless on three sides with a border on the bottom.

 

selecting image size

Open the file in a software application and assign the image size. Ensure that the size 
corresponds to the paper size on which you want to print the image.

printing

Follow these steps to print a borderless document:



1.  Open the file you want to print.

2.  Open the Printer Properties dialog box.

3.  Click the Paper/Quality tab.

 

4.  Select one of the borderless paper sizes from the Size is drop-down list.

5.  Select the appropriate paper type in the Type is drop-down list.

6.  Click the Borderless Auto Fit checkbox to automatically resize the image to 
print without a border.

 
The Borderless Auto Fit option is only available for photo 
paper types.

7.  Select any other desired print settings, then click OK.



print settings

The printer is controlled by software installed on your computer. Use the printer 
software, known as the printer driver, to change the print settings for a document.

To change the print settings, open the Printer Properties dialog box.

displaying the printer properties dialog box

Follow these steps to display the Printer Properties dialog box:

1.  Open the file you want to print.

2.  Click File > Print, then select Properties. The Printer Properties dialog box 
appears.

 
The path to the Printer Properties dialog box may vary depending 
on the software program.

using the printer properties dialog box

The Printer Properties dialog box has several tools that make it easy to use.

buttons and menus

The Printer Properties dialog box has the following features:



 

1.  Tabs: Click a tab to see its contents.

2.  Print Task Quick Sets: See print task quick sets.

3.  Preview: Shows how changes to the print settings affect the printout.

4.  Buttons:

❍     OK: Saves and applies changes.

❍     Cancel: Closes the dialog box without saving the new settings.

❍     Help: Offers instructions for using the What's This? help feature.

An Apply button may also appear. The Apply button saves changes to the 
settings without closing the dialog box.

 

To find more information about options on each tab screen, point to 
an option and click the right mouse button to display the What's 
This? dialog box. Click What's This? to view more information about 
the selected item.

tabs

●     paper/quality tab 



●     finishing tab 

●     effects tab 

●     basics tab 

●     color tab 

 
Printer features, and instructions on how to use them, are subject 
to change. This document was released for publishing before all of 
the printer features were determined.



print task quick sets

Use print task quick sets to print with or save print settings you use often.

For example, if you frequently print envelopes, you can create a print task that 
contains the paper size, print quality, and orientation setting you normally use for 
envelopes. After creating the print task, simply select it when printing envelopes 
rather that setting each of the print settings separately.

Create your own print task or use the specially designed print tasks available in the 
Print Task Quick Sets drop-down list.

using a print task quick set

Follow these steps to use a print task quick set:

1.  Open the Printer Properties dialog box.

2.  Select the print task you want to use from the drop-down list.

 

3.  Click OK.



 
To restore default print settings, select Default Print Settings from 
the Print Task Quick Sets drop-down list, and click OK.

creating a print task quick set

Follow these steps to create a print task quick set:

1.  Open the Printer Properties dialog box.

 

2.  Select the options you want to include in the new print task.

3.  Enter a name for the new print task in the Print Task Quick Sets drop-down 
list, then click Save.

The print task quick set is added to the drop-down list.

 
If you add more options to the print task, you must rename the 
print task, then click OK.

deleting a print task quick set

Follow these steps to delete a print task quick set:



1.  Open the Printer Properties dialog box.

2.  Select the print task you want to delete from the drop-down list, then click 
Delete.

 Some print task quick sets cannot be deleted.



paper/quality tab

The Paper/Quality tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Size is: Size of paper used.

3.  Custom: See setting a custom paper size.

4.  Type is: Type of paper used.

5.  Borderless Auto Fit: Select to fit the printed image across the entire page 
when printing a borderless document on certain paper types.

6.  Print Quality: There are five print quality options: FastDraft, Fast Normal, 
Normal, Best, and Maximum dpi. As print quality increases from FastDraft to 
Maximum dpi, the quality of the printed image improves and the print speed 
decreases. FastDraft uses the least amount of ink. Maximum dpi mode uses 
the most amount of ink and requires a large amount of disk space.

7.  hp Digital Photography: See printing digital photographs.



8.  Printing Tips: Printing ideas.



setting a custom paper size

Use the Custom Paper Size dialog box to print on a special paper size.

defining a custom paper size

Follow these steps to define a custom paper size:

1.  Open the Printer Properties dialog box.

2.  Click the Paper/Quality tab.

 

3.  Click the Custom button.

The Custom Paper Size dialog box is displayed.



 

4.  Select a custom paper size name from the Name drop-down list.

5.  Enter the paper dimensions in the Width and Length boxes.

The minimum and maximum paper dimensions appear beneath each of the 
boxes.

6.  Select the unit of measurement: Inches or Millimeters.

7.  Click Save to save the custom paper size.

You can save up to five custom paper sizes.

8.  Click OK to exit the Custom Paper Size dialog box.



printing digital photographs

The printer has several features to enhance the quality of digital photographs.

opening the hp digital photography options dialog box

Follow these steps to open the hp Digital Photography Options dialog box:

1.  Open the Printer Properties dialog box.

2.  Click the Paper/Quality tab, then click the hp Digital Photography button.

using the hp digital photography options dialog box

Use the hp Digital Photography Options dialog box to set these options:

 

1.  Red Eye Removal: Click On to remove or reduce red-eye from the 
photograph.

2.  Contrast Enhancement: Adjust contrast to preference. Click Automatic to 
allow the printer driver to automatically balance the contrast.

3.  Digital Flash: Lighten dark images. Click Automatic to allow the printer driver 
to automatically balance lightness and darkness.

4.  SmartFocus: Click On to allow the printer driver to automatically focus 



images.

5.  Sharpness: Adjust image sharpness to preference. Click Automatic to allow 
the printer driver to automatically sharpen the image.

6.  Smoothing: Adjust distortion to preference. Click Automatic to allow the 
printer driver to automatically smooth the image.



finishing tab

The Finishing tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print on Both Sides: See two-sided printing.

3.  Booklet Layout is: See printing a booklet.

4.  Pages per Sheet: See printing multiple pages on a single sheet of paper.

5.  Poster Printing: Select the number of pages you want your poster printed 
across to determine the size of your poster.

6.  Rotate By 180 Degrees: Rotates the printed image 180 degrees.



two-sided printing

Two-sided printing, also called duplexing, allows you to print on both sides of the 
paper. Printing on both sides of the paper is not only economical, but environmentally 
conscious as well.

printing instructions

Follow these steps to print a two-sided document manually:

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.

 

3.  Select Print on Both Sides.

4.  Select a binding option:

❍     For book binding: Verify that Flip Pages Up is not selected.



 
1. landscape 2. portrait

❍     For tablet binding: Select Flip Pages Up.

 
1. landscape 2. portrait

5.  Select any other desired print settings, then click OK.

The printer prints the odd-numbered pages first.

6.  Once the odd-numbered pages have printed, reload the paper, with the printed 
side facing up, according to the binding type and orientation selected:

❍     Book binding with portrait orientation: Reload the paper as shown below:

 

❍     Book binding with landscape orientation: Reload the paper as shown below:

 



❍     Tablet binding with portrait orientation: Reload the paper as shown below:

 

❍     Tablet binding with landscape orientation: Reload the paper as shown below:

 

7.  Click Continue to print the even-numbered pages.



printing a booklet

Booklet printing automatically arranges and resizes the pages of a document so when 
the document is folded into a booklet, the page order is correct.

For example, if a four-page booklet was printed on both sides of the paper, the pages 
would be reordered and printed like this:

 

To print a booklet, follow these steps:

1.  Open the Printer Properties dialog box.

2.  Select the Finishing tab.



 

3.  Select Print on Both Sides.

4.  Select a binding option in the Booklet Layout is drop-down list:

❍     Right Edge Binding: Places the binding on the right side of the booklet.

 

❍     Left Edge Binding: Places the binding on the left side of the booklet.

 

5.  Do one of the following:

❍     To leave every other page of the booklet blank, select Print On One Side.

❍     To print on all pages in the booklet, leave Print On One Side unchecked.



6.  Select any other desired print settings, then click OK.

7.  When prompted, reload the paper in the In tray as shown below.

 

8.  Click Continue to finish printing the booklet.



printing multiple pages on a single sheet of paper

The printer software allows you to print multiple pages of a document on a single 
sheet of paper. The printer software automatically resizes the document text and 
images to fit on the printed page.

Follow these steps to print multiple pages of a document on a single sheet of paper:

1.  Open the Printer Properties dialog box.

2.  Click the Finishing tab.

 

3.  From the Pages Per Sheet drop-down list, select the number of pages you want 
to appear on each sheet of paper.

4.  If you want a border to appear around each page image printed on the sheet 
of paper, click the Print Page Borders checkbox.

5.  Select a layout for each sheet of paper from the Page Order Is drop-down list.

6.  Select any other desired print settings, then click OK.



effects tab

The Effects tab allows you to set the following options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print Document On: Prints a document on a paper size different than the 
paper size for which it is formatted. Select the target paper size from the drop-
down list.

3.  Scale to Fit: Automatically resizes the printed image to fit on the paper size 
selected in the Print Document On drop-down list.

4.  % of Normal Size: Specify the percentage to which you want to reduce or 
enlarge the printed image. For example, enter 70 to reduce the printed image 
to 70 percent of its normal size.

5.  Watermarks: See watermarks.



watermarks

Watermarks appear as background printing on documents.

applying an existing watermark to a document

Follow these steps to apply an existing watermark to a document:

1.  Open the Printer Properties dialog box.

2.  Click the Effects tab.

 

3.  Select a watermark from the Watermarks drop-down list.

If you do not want to use one of the listed watermarks, create a new 
watermark.

4.  Do one of the following:

❍     If you want the watermark to appear on the first page only, select First Page 
Only.

❍     If you want the watermark to appear on all printed pages, leave First Page 



Only unchecked.

5.  Print the document according to the instructions for the paper type.

creating or changing a watermark

Follow these steps to create or change a watermark:

1.  Open the Printer Properties dialog box.

2.  Click the Effects tab.

3.  Click the Edit button.

The Watermark Details dialog box appears.

 

4.  Do one of the following:

❍     Click the New button, or

❍     Select an existing watermark to change.

5.  Enter the watermark message, message angle, and font attributes.

6.  After you have set the watermark details, click OK.

For instructions on applying watermarks, click here.



 

To find more information about options on each tab screen, point to 
an option and click the right mouse button to display the What's 
This? dialog box. Click What's This? to view more information about 
the selected item.



basics tab

The Basics tab allows you to set the following options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Orientation: Specify the page layout:

❍     Portrait: The printed page is longer than it is wide.

❍     Landscape: The printed page is wider than it is long.

❍     Mirror Image: Reverses the printed image from left to right.

3.  Page Order: Select one of the following:

❍     Front to Back: First page will be on top when the document is finished 
printing.

❍     Back to Front: Last page will be on top when the document is finished 
printing.

4.  Copies: Number of copies printed.

5.  Print Preview: Select to view the layout of a document before it prints.



6.  Advanced Features: See advanced features.



advanced features

Printing photographs, transparencies, or documents with graphics may require you to 
set options on the Advanced Features dialog box.

opening the advanced features dialog box

Follow these steps to open the Advanced Features dialog box:

1.  Open the Printer Properties dialog box.

2.  Click the Basics tab, then click the Advanced Features button.

using the advanced features dialog box

Use the Advanced Features dialog box to set these options:

 

1.  Ink Volume: Adjusts the amount of ink printed on a page. Reducing the ink 
volume reduces the color quality.

2.  Dry Time: Provides extra drying time for slow-drying printouts.

3.  Low Memory Mode: Allows a document to be printed from a computer that 
does not have enough memory or disk space to print the document under 
normal conditions. Using this option may reduce the quality of the printout. 
The Maximum dpi print quality mode is not available when the printer is in Low 



Memory Mode.



color tab

The Color tab allows you to set these options:

 

1.  Print Task Quick Sets: See print task quick sets.

2.  Print in Grayscale: Prints in shades of gray.

❍     High Quality: Uses the tri-color print cartridge and/or photo print 
cartridge to print high-quality grayscale.

❍     Black Print Cartridge Only: Uses the black print cartridge to print 
grayscale.

❍     Optimize For Photocopy or Fax: Uses the black print cartridge to 
print grayscale suitable for photocopying and faxing.

3.  Saturation: Adjusts the intensity of printed colors.

4.  Brightness: Adjusts the lightness or darkness of printed colors.

5.  Color Tone: Adjusts the warmth or coolness of printed colors.



buttons and light

Use the printer buttons to turn the printer on and off and cancel a print job.

 
1. power button and light 2. print cancel button

power button and light

The Power button turns the printer on and off. It may take a few seconds for the 
printer to turn on after pressing the Power button.

The light on the Power button gives you visual cues about the status of the printer. 
When the Power light is on and not flashing, the printer is either printing or ready to 
print. When the Power light is flashing, the printer cover is open or there may be a 
problem.

Caution!   Always use the Power button to turn the printer on and off. 
Using a power strip, surge protector, or a wall-mounted switch to turn 
the printer on and off may cause printer failure.

print cancel button

Pressing the Print Cancel button cancels the current print job.



power light is flashing

●     If the Power light is on, the printer is either printing or ready to print.

●     If the Power light is off, the printer is off.

●     If the Power light is flashing, see below.

 
1. power light

what the flashing light means

The Power light can flash for several reasons:

●     The printer cover is open.

●     The printer is out of paper.

●     There is a problem with the printer, such as a paper jam or a problem with a 
print cartridge.

if an error message appears

Read the error message explaining the problem and its solution.

if no error message appears

1.  Go to maintenance.

2.  Click any of the four main buttons.

This will tell the software to check the status of the printer.



3.  Read any error messages explaining the problem and its solution.



paper jam

Follow each of these steps until the paper jam is cleared.

1.  Remove the paper from the In tray.

2.  If you are printing labels, verify that a label did not become detached from the 
label sheet while passing through the printer.

3.  Remove the Rear Access Door. Press the handle to the right, then pull out the 
door.

 

4.  Remove the paper jam from the back of the printer, then replace the Rear 
Access Door.

 

5.  Reload paper in the In tray.

6.  Reprint the document.



device status box

The Device Status Box appears each time the printer prints a file.

 

The following items are displayed:

1.  Ink Levels: Approximate ink level of each print cartridge.

2.  Device Status: The status of the printer. For example, Spooling or Printing.

3.  Document Properties: The following information about the current print job 
is provided.

❍     Document: Name of the document that is currently printing.

❍     Print Quality: Print quality setting being used.

❍     Paper Type: Type of paper used.

❍     Paper Size: Size of paper used.

To cancel a print job, click Cancel Print.

To close the Device Status Box, click Close Window.



getting started

●     printer features 

●     buttons and light 

●     paper trays 

●     print cartridges 

●     ink-backup mode 



printer features

The printer has several features to make printing easier and more efficient.

 

1.  buttons and light 

2.  paper trays 

 

1.  print cartridges 

2.  ink-backup mode 



 

1.  usb port 



paper trays

The printer has a fold-up paper tray that contains an In tray and an Out tray.

For information about the paper tray, select one of the topics below:

●     unfolding the paper trays 

●     in tray 

●     out tray 

●     folding the paper trays 

unfolding the paper trays

Follow these steps to unfold the paper trays:

1.  Raise the printer cover.

 

2.  Lower the In tray.

 

3.  Lower the Out tray.



 

4.  Pull out the Out tray extension, then unfold the Out tray extension stop.

 

5.  Lower the printer cover and turn on the printer.

 

in tray

The In tray holds paper and other media to be printed.



 
1. in tray

You can print different sizes of media by sliding the paper guide left and right.

 
1. press and slide the paper guide

out tray

Printed pages are deposited in the Out tray.

 
1. out tray

Raise the printer cover and the Out tray to load paper.

Lower the printer cover and the Out tray before printing.



To prevent paper from falling out of the tray, pull out the Out tray extension, then 
unfold the Out tray extension stop.

 
1. out tray extension and out tray extension stop

folding the paper trays

Follow these steps to refold the paper trays:

1.  Remove paper or other media from the paper trays, then turn off the printer.

2.  Raise the printer cover.

 

3.  Fold the Out tray extension stop, then push the Out tray extension into the Out 
tray.



 

4.  Raise the Out tray.

 

5.  Raise the In tray.

 

6.  Reach underneath the In tray, then lift the tray until it locks into place.



 

7.  Lower the printer cover.



ink-backup mode

Ink-backup mode allows the printer to operate using only one print cartridge. It is 
initiated when a print cartridge is removed from the cradle.

For instructions on removing a print cartridge, click here.

ink-backup mode output

Printing in ink-backup mode slows the printer and affects the quality of printouts.

when only this print cartridge is 
installed... the result is...

black print cartridge Colors are printed as grayscale.

tri-color print cartridge Colors print but black is grayed and 
is not a true black.

photo print cartridge
Colors are printed as grayscale, 
black is grayed and is not a true 
black.

 
It is recommended that you do not use the photo print cartridge for 
ink-backup mode.

exiting ink-backup mode

Install two print cartridges in the printer to exit ink-backup mode.

For instructions on installing a print cartridge, click here.



USB

The printer connects to the computer with a Universal Serial Bus (USB) cable. The 
computer must be running Windows 98 or later to use a USB cable.

 

For instructions on connecting the printer with a USB cable, see the setup poster that 
came with the printer.



connectivity

●     USB 



printing

Click the appropriate topic below to view an explanation of the printer software:

●     print settings 

●     advanced features 

●     device status box 

Click the appropriate topic below to view instructions on printing functions:

●     printing a document 

●     changing default settings 

●     two-sided printing 

●     print task quick sets 

●     printing digital photographs 

●     borderless printing 

●     printing a booklet 

●     setting custom paper sizes 

●     printing multiple pages on a single sheet of paper 

●     watermarks 

Click the appropriate topic below to view instructions for printing:

●     plain paper 

●     envelopes 

●     transparencies 

●     labels 

●     index cards and other small media 

●     greeting cards 

●     photographs 

●     posters 

●     iron-on transfers 



printing a document

basic printing instructions

Follow these steps to print a document:

1.  Open the file you want to print.

2.  Click File > Print.

3.  Click OK to print with the printer's default print settings.

setting printing options

Follow these steps to change printing options:

1.  Open the file you want to print.

2.  Click File > Print, then select Properties.

The Printer Properties dialog box appears.

 
The path to the Printer Properties dialog box may vary 
depending on the software program.

3.  Specify the print settings shown below:

❍     Select the Paper/Quality tab to choose paper options, borderless printing, 
and print quality, or to access the HP digital photography options.

❍     If you want to use preset print settings, choose a Print Task Quick Set.

❍     Select the Finishing tab to choose document options, print posters, or rotate 
the printed image by 180 degrees.

❍     Select the Effects tab to choose resizing options.

❍     Select the Basics tab to choose orientation and page order options, specify 
the number of copies printed, enable Show Print Preview, or access Advanced 
Features.

❍     Select the Color tab to choose color options and color attributes.

4.  Click OK, then follow the application's instructions to print the document.



posters

guidelines

●     After the sections of a poster have been printed, trim the edges of the sheets, 
then tape the sheets together.

 

●     In tray capacity: Up to 100 sheets

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Place the paper in the In tray, then push it into the printer until it stops.

5.  Lower the Out tray.

6.  Slide the paper guide firmly against the edge of the paper.

7.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality Type is: Plain Paper

Finishing Poster Printing: 2 x 2, 3 x 3, 4 x 4 or 5 x 5



2.  Select any other desired print settings, then click OK.



changing default settings

Use the taskbar icon to change the printer's default print settings. The default print 
settings apply to all documents printed by the printer.

 
1. taskbar icon

using the taskbar icon shortcut menu

Follow these steps to change the printer's default settings:

1.  Click the taskbar icon.

The Printer Properties dialog box appears.

2.  Select the options you want to use as the default settings.

3.  Click OK.

A dialog box appears stating that the new settings will be used every time you 
print. If you do not want to see this dialog box again, select Don't show me 
this message again.

4.  Click OK to save the new default print settings.



plain paper

guidelines

In tray capacity: Up to 100 sheets

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Place the paper in the In tray, then push it into the printer until it stops.

Legal-size paper will extend beyond the edge of the In tray.

 

5.  Lower the Out tray.

6.  Slide the paper guide firmly against the edge of the paper.

7.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality Type is: Plain Paper

2.  Select any other desired print settings, then click OK.



envelopes

guidelines

●     Avoid using envelopes that: have clasps or windows; have thick, irregular, or 
curled edges; are shiny or embossed; are wrinkled, torn, or otherwise 
damaged.

●     Align the envelope edges before inserting them in the In tray.

●     In tray capacity: Up to 10 envelopes

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Place the envelopes, with the printable side down and the flap to the left, in 
the right-hand side of the In tray. Push the envelopes into the printer until 
they stop.

 

5.  Lower the Out tray.

6.  Slide the paper guide firmly against the edge of the envelopes.

7.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: Appropriate envelope size
Type is: Plain Paper

2.  Select any other desired print settings, then click OK.



transparencies

guidelines

●     For great results, use HP brand inkjet transparency film.

●     In tray capacity: Up to 30 transparencies

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Place the transparencies, with the printable side down and the adhesive strip 
toward the printer, in the In tray. Carefully push the transparencies into the 
printer until they stop so that none of the adhesive strips catch on one another.

 

5.  Lower the Out tray.

6.  Slide the paper guide firmly against the edge of the transparencies.

7.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality Type is: Appropriate transparency film



2.  Select any other desired print settings, then click OK.



labels

guidelines

●     Use only paper labels that are designed specifically for inkjet printers.

●     Use only full sheets of labels.

●     Verify that the labels are not sticky, wrinkled, or pulling away from the 
protective backing.

●     Do not use plastic or clear labels. The ink will not dry on these labels.

●     In tray capacity: Up to 20 sheets of labels (use only Letter- or A4-sized sheets)

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Fan the edges of the label sheets to separate them, then align the edges.

5.  Place the label sheets, with the label side down, in the In tray, then push the 
sheets into the printer until they stop.

 

6.  Lower the Out tray.

7.  Slide the paper guide firmly against the edge of the paper.

8.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:



tab setting

Paper/
Quality 

Size is: Letter or A4
Type is: Plain Paper

2.  Select any other desired print settings, then click OK.



index cards and other small media

guidelines

●     Use only cards and small media that meet the printer's paper size 
specifications. For specifications, see the reference guide that came with the 
printer.

●     In tray capacity: Up to 30 cards

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Place the cards, with the printable side down and the short edge pointing 
towards the printer, in the right side of the In tray.

 

5.  Lower the Out tray.

6.  Slide the paper guide firmly against the edge of the paper.

7.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: Appropriate card size
Type is: Plain Paper

2.  Select any other desired print settings, then click OK.

If an out of paper message appears, click here.



error messages

out of paper message

if the in tray is loaded

1.  Verify the following:

❍     There is sufficient paper in the In tray (at least ten sheets).

❍     The In tray is not overly full.

❍     The paper stack is touching the back of the In tray.

2.  Slide the paper guide so that it fits firmly against the edges of the paper.

if the in tray is empty

1.  Load paper in the In tray.

2.  Push the paper forward until it stops.

3.  Slide the paper guide so that it fits firmly against the edges of the paper.

an error message appears while the power light is flashing

Read the error message explaining the problem and its solution.

For more information, see power light is flashing.

the error message 'there was an error writing to USB port' appears

The printer may not be receiving correct data from another USB device or USB hub. 
Connect the printer directly to the USB port on the computer.

the error message 'there was an error writing to LPT1' appears

If the printer is connected to the computer with a USB cable, the cable may not have 
been attached before installing the software.

Uninstall, then reinstall, the software.

To uninstall the software, click here.

the error message 'two-way communication cannot be established' or 'printer 
not responding' appears

The printer may not be able to communicate with the computer if the USB cable is 
too long.

If you receive this error message, ensure the USB cable is not greater than five 
meters (approximately 16 feet, five inches) in length.





greeting cards

guidelines

●     Unfold pre-folded cards, then place them in the In tray.

●     For great results, use HP Greeting Card Paper.

●     In tray capacity: Up to 20 cards

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Fan the edges of the greeting cards to separate them, then align the edges.

5.  Place the greeting cards, with the printable side down, in the In tray. Push the 
cards into the printer until they stop.

 

6.  Lower the Out tray.

7.  Slide the paper guide firmly against the edge of the greeting cards.

8.  Lower the printer cover.

printing

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: Appropriate card size
Type is: Appropriate card type

Basics Orientation: Appropriate orientation

2.  Select any other desired print settings, then click OK.

If an out of paper message appears, click here.



photographs

guidelines

●     The photo must be in electronic (digital) format before it can be printed. Take 
a digital picture, scan a photo, or have your local camera shop provide an 
electronic file of the photo.

●     Use HP brand photo paper for outstanding results.

●     For high-quality results, use a high-resolution print setting and set the HP 
digital photography options.

●     For maximum fade resistance, use HP Premium Plus Photo Paper and install a 
photo print cartridge in the printer.

●     For instructions on borderless printing, click here.

●     In tray capacity: Up to 30 sheets

preparing to print

1.  Raise the printer cover.

2.  Slide the paper guide to the left.

3.  Raise the Out tray.

4.  Do one of the following:

❍     Small photographs: Place the photo paper, with the printable side down 
and the tear-off tab facing away from the printer, in the In tray.

 

❍     Large photographs: Place the photo paper, with the printable side down, in 
the In tray.



 

5.  Push the photo paper into the printer until the paper stops.

6.  Lower the Out tray.

7.  Slide the paper guide firmly against the edge of the paper.

8.  Lower the printer cover.

printing photographs

 
If your software program includes a photo printing feature, follow 
the instructions provided with the software program. Otherwise, 
follow the instructions below.

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Size is: Appropriate photo paper size
Type is: Appropriate photo paper type
Print Quality: Normal, Best or Maximum dpi
hp Digital Photography: Desired photo enhancement 
options

2.  Select any other desired print settings, then click OK.

If an out of paper message appears, click here.

printing Exif Print-enhanced photographs

Exif Print (Exchangeable Image File Format 2.2) is an international digital imaging 
standard that simplifies digital photography and enhances printed photographs. When 
a photograph is taken with an Exif Print-enabled digital camera, Exif Print captures 



information such as exposure time, type of flash, and color saturation, and stores it in 
the image's file. The HP Deskjet printer software then uses this information to 
automatically perform image specific enhancements, resulting in outstanding 
photographs.

Printing Exif Print-enhanced photos requires:

●     A digital camera that supports Exif Print

●     Exif Print-enabled photo software

●     HP Deskjet printer software that supports Exif Print

●     Windows 98, 2000, Me, or XP

Follow these steps to print Exif Print-enhanced photographs:

1.  Open the file you want to print using Exif Print-enabled photo software.

2.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Type is: Appropriate photo paper type
Print Quality: Best or Normal

3.  Select any other desired print settings, then click OK.

The printer software automatically optimizes the printed image.

PhotoREt printing

PhotoREt offers the best combination of print speed and quality for your image.

Follow these steps to print with PhotoREt technology:

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality Print Quality: Best

2.  Select any other desired print settings, then click OK.

4800 x 1200 optimized dpi

4800 x 1200 optimized dpi is the highest quality resolution for this printer. When 
Maximum dpi is selected in the printer driver, the tri-color printcartridge prints in the 



4800 x 1200 optimized dpi mode. If a photo print cartridge is also installed, the print 
quality is enhanced. A photo print cartridge may be purchased separately if it is not 
included with your printer.

Follow these steps to print in 4800 x 1200 optimized dpi mode:

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Type is: Appropriate photo paper type
Print Quality: Maximum dpi

2.  Select any other desired print settings, then click OK.

six-ink color printing

Use six-ink color printing to enhance the quality of photographs.

For six-ink color printing, a photo and a tri-color print cartridge must beinstalled. A 
photo print cartridge may be purchased separately if it is not includedwith your 
product.

Follow these steps to print in six-ink color print mode:

1.  Open the Printer Properties dialog box, then select the following:

tab setting

Paper/
Quality 

Type is: Appropriate photo paper type
Print Quality: Normal, Best, or Maximum dpi

2.  Select any other desired print settings, then click OK.



iron-on transfers

guidelines

●     Use HP Iron-on Transfers for great results.

●     When printing a mirror image, the text and the pictures are horizontally 
reversed from what appears on the computer screen.

 

●     In tray capacity: Up to 100 sheets

preparing to print

1.  Raise the printer cover.

2.  Slide the paper width guide to the left.

3.  Raise the Out tray.

4.  Place the paper in the In tray, with the printable side down, then push it into 
the printer until it stops.

5.  Lower the Out tray.

6.  Slide the paper width guide firmly against the edge of the paper.

7.  Lower the printer cover.

printing

 
If your software program includes an iron-on transfer printing 
feature, follow the instructions provided with the software program. 
Otherwise, follow the instructions below.

1.  Open the Printer Properties dialog box, then select the following:

tab setting



Paper/
Quality 

Size is: A4 or Letter
Type is: hp iron-on transfer
Print Quality: Normal or Best

Basics Orientation: Mirror Image

2.  Select any other desired print settings, then click OK.



maintenance

●     replacing print cartridges 

●     calibrating print cartridges 

●     automatically cleaning print cartridges 

●     manually cleaning print cartridges 

●     maintaining print cartridges 

●     maintaining the printer body 

●     removing ink from skin and clothing 

●     printer tools 



automatically cleaning print cartridges

If your printed pages are missing lines or dots, or if they contain ink streaks, the 
print cartridges may be low on ink or may need to be cleaned.

Click here to check the print cartridge ink levels.

If the print cartridges are not low on ink, follow these steps to clean the print 
cartridges automatically:

1.  Go to printer maintenance.

2.  Click Clean Cartridges.

3.  Click Clean, then follow the onscreen instructions.

If your printouts are still missing lines or dots after cleaning, replace the print 
cartridges.

Caution!   Clean print cartridges only when it is necessary. 
Unnecessary cleaning wastes ink and shortens the life of the cartridge.



manually cleaning print cartridges

If the printer is used in a dusty environment, a small amount of debris may 
accumulate inside the case. This debris can include dust, hair, carpet, or clothing 
fibers. When debris gets on the print cartridges and cradle, it can cause ink streaks 
and smudges on printed pages. Ink streaking is easily corrected by manually cleaning 
the cartridges and cradle.

gathering cleaning supplies

You will need the following items to clean the print cartridges and cradle.

●     Distilled water

●     Cotton swabs or other soft, lint-free material that will not stick to the cartridges

Be careful not to get ink on your hands or clothing as you clean.

preparing to clean

1.  Press the Power button to turn on the printer, then raise the printer cover.

The cradle moves to the center of the printer.

2.  Disconnect the power cord from the back of the printer.

3.  Remove the print cartridges and place them on a piece of paper with the 
nozzle plate facing up.

Caution!   Do not leave the print cartridges outside the printer for 
more than 30 minutes.

cleaning the print cartridges and print cartridge cradle

1.  Lightly moisten a cotton swab with distilled water.

2.  Clean the face and edges of the first print cartridge with the swab, as shown in 
the following illustration.

Do not wipe the nozzle plate.



 
1. nozzle plate and ink nozzles 2. faces and edges of print cartridge 3. copper 
contacts

Caution!   Do not touch the print cartridge ink nozzles or copper 
contacts. Touching these parts will result in clogs, ink failure, and 
bad electrical connections.

3.  Inspect the face and edges of the print cartridge for fibers.

Repeat steps 1 and 2 above if fibers are still present.

4.  Repeat steps 1 through 3 for the second print cartridge.

5.  Wipe the underside of the print cartridge cradle walls using clean, moistened 
cotton swabs.

Repeat this process until no ink residue appears on a clean swab.

 



1. print cartridge cradle 2. print cartridge cradle walls

6.  Insert the print cartridges and close the printer cover.

7.  Connect the power cord to the back of the printer.

8.  Press the Power button to turn on the printer.

9.  Calibrate the print cartridges.

Repeat the cleaning procedure if ink streaks continue to appear on printed pages.



removing ink from skin and clothing

Follow these instructions to remove ink from skin and clothing:

to remove ink from... do this...

skin Wash the affected area with an abrasive soap.

white fabric Wash the fabric in cold water using chlorine bleach.

color fabric Wash the fabric in cold water using sudsy ammonia.

Caution!   Always use cold water to remove ink from fabric. Warm or 
hot water may set the ink color into the fabric.



maintaining the printer body

Because the printer ejects ink onto the paper in a fine mist, ink smudges will 
eventually appear on the printer case and adjacent surfaces. To remove smudges, 
stains, and/or dried ink from the exterior of the printer, use a soft cloth moistened 
with water.

When cleaning your printer, keep these tips in mind:

 

●     Do not clean the interior of the printer. Keep all fluids away from the 
interior.

●     Do not use household cleaners or detergent. In the event that a 
household cleaner or detergent is used on the printer, wipe the 
printer's exterior surfaces with a soft cloth moistened with water.

●     Do not lubricate the support rod that the print cartridge cradle uses 
to slide back and forth. Noise is normal when the cradle moves back 
and forth.



printer tools

The printer software contains a number of useful tools to enhance the printer's 
performance.

Use the printer tools to:

●     View estimated ink levels.

●     Clean the print cartridges.

●     Calibrate the printer.

●     Print a test page.

●     Perform other functions as needed.

To access the tools, click here.



troubleshooting

●     printer is not printing 

●     paper jam 

●     paper problems 

●     print quality is poor 

●     document is misprinted 

●     photos are not printing correctly 

●     borderless printing problems 

●     power light is flashing 

●     printer is slow 

●     error messages 

●     if you continue to have problems 



printer is not printing

verify the following

●     Printer is connected to the power source.

●     Cable connections are secure.

●     Printer is turned on.

●     Print cartridges are correctly installed.

●     Paper or other media is correctly loaded in the In tray.

●     Printer cover is closed.

●     Rear Access Door is attached.

check the power light

If the Power light is flashing, there may be an error.

See power light is flashing for more information.

check the printer cable connection

If the printer cable is attached to a USB hub, there may be a printing conflict. There 
are two methods for solving the conflict:

●     Attach the printer's USB cable directly to your computer, or

●     When printing, do not use other USB devices that are attached to the hub.

if the printer does not turn on

The printer may have drawn too much power.

1.  Disconnect the power cord from the electrical outlet.

2.  Wait approximately 10 seconds.

3.  Reconnect the power cord.

4.  Press the Power button to turn on the printer.

If the printer still does not turn on, try the following:

●     Plug the printer into another electrical outlet, or

●     Plug the printer directly into an electrical outlet rather than into a surge 
protector.



if the printer still does not print

Select the topic below that best describes the problem:

●     paper jam 

●     out of paper message

●     onscreen error message



paper problems

the printer prints on multiple sheets at once

paper weight

The printer may print on multiple sheets of paper at once if the paper is below the 
recommended paper weight. Use paper that meets the recommended paper weight. 
For paper weight specifications, see the reference guide that came with the printer.

paper may be loaded improperly

The printer may print on multiple sheets of paper at once if the paper is loaded too 
far toward the back of the printer. Reload paper into the paper tray, pushing the 
paper until you feel resistance.

other paper problems

●     For information on clearing a paper jam, click here.

●     If an out of paper message appears, click here.



print quality is poor

streaks and missing lines

If your printed pages are missing lines or dots or if streaks appear, the print 
cartridges may be low on ink or may need to be cleaned.

print is faded

●     Verify that a black print cartridge is installed.

If the black text and images on your printouts are faded, you may be printing 
using only the tri-color print cartridge. Insert a black print cartridge, in 
addition to the tri-color print cartridge, for optimal black print quality.

●     Verify that neither of the print cartridges is low on ink.

If a print cartridge is low on ink, consider replacing the print cartridge. For the 
correct part numbers, see print cartridges.

●     Verify that the protective piece of plastic tape has been removed from the print 
cartridges.

 
1. plastic tape

●     Consider selecting a higher print quality.

increase the ink volume

1.  Open the Advanced Features dialog box.

2.  Move the Ink Volume slider toward Heavy.

3.  Move the Dry Time slider toward More.

4.  Click OK > OK.

blank pages print

●     The protective piece of plastic tape may still be attached to the print 



cartridges. Verify that the plastic tape has been removed from the print 
cartridges.

●     The print cartridges may be out of ink. Replace one or both empty print 
cartridges.

too much or too little ink appears on the page

adjust the ink volume and dry time

1.  Open the Advanced Features dialog box.

2.  Move the Ink Volume slider toward Light or Heavy.

 
If you increase the ink volume, move the Dry Time slider 
toward More to avoid smearing the ink.

3.  Click OK, then click OK again.

file:///I|/s03/3600/enu/toolsandupdates_home.html


document is misprinted

text and images are misaligned

If the text and images on your printouts are misaligned, then calibrate the printer.

document is printed off-center or at an angle

1.  Verify that the paper is correctly placed in the In tray.

2.  Verify that the paper guide fits firmly against the paper.

3.  Reprint the document.

envelope is printed at an angle

1.  Slide the flap inside the envelope before loading it in the In tray.

2.  Confirm that the paper guide fits firmly against the envelope.

3.  Reprint the envelope.

parts of the document are missing or printed in the wrong place

Open the Printer Properties and confirm the following options:

tab setting

Basics Orientation: Verify the appropriate orientation

Paper/
Quality Size is: Verify the appropriate paper size

Effects Scale to Fit: Select to scale text and graphics to the paper

Finishing Poster Printing: Verify that Off is selected

printout does not reflect new print settings

The printer's default settings may differ from the software application's print settings. 
Select the appropriate print settings within the software application.



photos are not printing correctly

check the paper tray

1.  Verify that the photo paper is placed in the In tray with the printable side down.

2.  Slide the paper forward until it stops.

3.  Slide the paper guide firmly against the paper.

check the printer properties

Open the Printer Properties dialog box and verify the following options:

tab setting

Paper/
Quality 

Size is: Appropriate size
Type is: Photo Paper
Print Quality: Best



borderless printing problems

image is printed at an angle

if your printout looks like this

 

do this

1.  Load the paper correctly in the In tray.

2.  Verify that the paper guide fits firmly against the cards or photo paper.

3.  Follow loading instructions for the paper type.

See borderless printing.

border is on top of image

if your printout looks like this

 



do this

Calibrate the printer.

border is on side of image

if your printout looks like this

 

do this

Calibrate the printer.

image is above tear-off tab

if your printout looks like this

 

do this

Calibrate the printer.

ink smears



if your printout has ink smears

Ink smears appear on the back of the printouts, or the paper sticks together.

do this

1.  Open the Advanced Features dialog box.

2.  Move the Dry Time slider toward More.

3.  Move the Ink Volume slider toward Light.

 The colors in the image may become lighter.

4.  Click OK.

If the problem persists:

1.  Remove the borderless printing media, then load plain paper in the In tray.

2.  Press and hold down the Print Cancel button until the printer starts printing a 
self-test page, then release the button.

3.  Repeat step 2 until the self-test has no ink smears on the back of the paper.



printer is slow

Several variables can slow the printer's performance.

multiple software applications are open

The computer does not have sufficient resources for the printer to print at its 
optimum speed.

To increase printer speed, close all unnecessary software applications when printing.

complex documents, graphics, or photographs are printing

Documents containing graphics or photographs print slower than text documents.

If your computer does not have enough memory or disk space to print the document 
under normal conditions, you can use Low Memory Mode. Using this option may 
reduce the quality of the printout. Low Memory Mode also disables 4800 x 1200 
optimized dpi printing.

To activate Low Memory Mode:

1.  Open the Printer Properties dialog box.

2.  Click the Basics tab, then click the Advanced Features button.

3.  Select Low Memory Mode.

4.  Print the document.

printer driver is outdated

An outdated printer driver may be installed.

For information about updating the printer driver, click here.

computer does not meet system requirements

If your computer does not have enough RAM or a large amount of free space on the 
hard drive, the printer processing time will be longer.

1.  Verify that the computer's hard disk space, RAM, and processor speed meet 
system requirements.

2.  Free up space on the hard drive.

printer is in ink-backup mode

The printer may print more slowly if it is in ink-backup mode.

To increase the print speed, use two print cartridges in the printer.



minimum system requirements

Your computer must meet the following minimum requirements:

Microsoft Windows XP

Minimum processor speed: Pentium 233 MHz

Required RAM: 128 MB

Required free hard disk space: 40 MB*

Microsoft Windows 98, Me

Minimum processor speed: Pentium 150 MHz

Required RAM: 32 MB

Required free hard disk space: 40 MB*

Microsoft Windows 2000 Professional

Minimum processor speed: Pentium 133 MHz

Required RAM: 64 MB

Required free hard disk space: 40 MB*

* If you are printing photographs, or printing very high resolution (4800 x 1200 
optimized dpi), you must have at least 400 MB of temporary hard disk space 
available.



if you continue to have problems

If you continue to have problems after investigating the troubleshooting topics, shut 
down, then restart your computer.

If you still have problems after restarting your computer, go to HP customer support 
at www.hp.com/support.



specifications

●     minimum system requirements 

●     environmental statement 

●     print cartridge recovery 



environmental statement

Hewlett-Packard continuously improves the design processes of its deskjet printers to 
minimize the negative impact on the office environment and on the communities 
where printers are manufactured, shipped, and used.

reduction and elimination

Paper use: The printer's two-sided printing capability reduces paper usage and the 
resulting demands on natural resources. This printer is suited for the use of recycled 
papers in accordance with DIN 19 309.

Recycled paper: All paper documentation for this printer is printed on recycled 
paper.

Ozone: Ozone-depleting chemicals such as CFCs have been eliminated from Hewlett-
Packard's manufacturing processes.

recycling

Design for recycling has been incorporated into this printer. The number of materials 
has been kept to a minimum while ensuring proper functionality and reliability. 
Dissimilar materials have been designed to separate easily. Fasteners and other 
connections are easy to locate, access, and remove using common tools. High priority 
parts have been designed to access quickly for efficient disassembly and repair.

Printer packaging: The packaging materials for this printer have been selected to 
provide maximum protection for the least cost possible, while attempting to minimize 
environmental impact and facilitate recycling. The rugged design of the HP Deskjet 
printer assists in minimizing both packaging materials and damage rates.

Plastic parts: All major plastics and plastic parts are marked according to 
international standards. All plastic parts used in the printer housing and chassis are 
technically recyclable and all use a single polymer.

Product longevity: To ensure the longevity of your HP Deskjet printer, HP provides 
the following:

●     Extended warranty: Details can be found in the reference guide that came 
with your printer.

●     Replacement parts and consumables are available for three (3) years after 
production has stopped.

●     Product take-back: To return this product to HP at the end of its useful life, 
go to www.hp.com/recycle. To return empty print cartridges to HP, see print 
cartridge recovery.



 
The extended warranty and product take-back options are 
not available in all countries/regions.

energy consumption

This printer was designed with energy conservation in mind. Not only does this save 
natural resources, but it also saves money without affecting the high performance of 
the printer.

This product qualifies for the ENERGY STAR® Program. ENERGY STAR is a voluntary 
program established to encourage the development of energy-efficient office products.

 

ENERGY STAR is a U.S. registered service mark of the U.S. Environmental Protection 
Agency. As an ENERGY STAR partner, Hewlett-Packard Company has determined that 
this product meets ENERGY STAR guidelines for energy efficiency.

Energy consumption in standby mode: See the reference guide for energy 
consumption specifications.

Energy consumption in off-mode: When the printer is off, an amount of energy is 
still being consumed. Energy consumption can be prevented by turning the printer 
power off, then disconnecting the end of the printer power cord from the electrical 
source.



user's guide other languages 

The User's Guide information is available in Adobe Acrobat format in the following 
languages. Select from the choices below: 
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